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SEG-Y Reader 
SEG-Y Reader reads 2D and 3D SEG-Y format data files and exports them to formats that may 
be loaded into GM-SYS Profile and/or Oasis montaj for 2D- and 3D-displays.  Supported output 
formats include: 

 Geosoft Database (2D & 3D SEG-Y).  Each trace is loaded into a database row.  
Samples and sample depths are stored as array channels.  (Requires an Oasis montaj 
license) 

 Geosoft voxel (geosoft_voxel) file (3D SEG-Y).  Voxel dimensions, spacing, and 
rotation must be specified.  (Requires an Oasis montaj license) 

 Windows BMP image (2D SEG-Y).  The image file is suitable for importing into GM-SYS 
as a bitmap backdrop.  The SEG-Y data may be projected onto a cross section defined 
by an existing GM-SYS model, onto a section defined by the endpoints of the SEG-Y file, 
onto an arbitrary section defined by an origin and azimuth, or displayed using along-line 
distance with no projection of data.  The coordinates for the bitmap corners are written on 
the bitmap, to make registering the image in GM-SYS easier. 

 Geosoft grid (GRD) file (2D SEG-Y).  This function utilizes the same parameters as the 
BMP output, but produces a grid properly oriented for insertion and display within a 3D 
View in Oasis montaj. 

Supported file formats 

SEG-Y Reader can read most files that adhere loosely to the original SEG-Y specification or the 
SEG-Y rev. 1 format specification, including: 

 ASCII or EBCDIC header format, 

 Big Endian or Little Endian byte order, 

 Trace data formats including: 
IBM Float (4-byte) 
IEEE Float (4-byte) 
Fixed (4-byte) 
Fixed (2-byte) 
Fixed (1-byte) 

SEG-Y Reader does not support the use of Extended Textual File Headers as described in the 
rev. 1 specification. 

Upon opening a file, the binary and trace headers will be scanned for format specifications.  The 
SEG-Y format specifies a byte-offset and data format for each trace header field (e.g. Group X-
coordinate & Group Y-coordinate at byte-offsets 80 and 84, both 4-byte integers).  In practice, 
binary header values are often absent or wrong, and trace header fields are frequently empty, in 
a different location, and/or stored in a different format. 

Opening the SEG-Y file 

When you open a SEG-Y file, you have the option to select Open SEG-Y and Generate Image 
with Default Settings, or Open SEG-Y and Edit settings option from the File menu.  If the file is a 
well behaved 2D SEG-Y file, you may have at least limited success with the first option.  
Otherwise, if you select Open SEG-Y and Edit settings, or wish to change the settings after 
generating an image (click on the Configure tab), you will be presented with a set of topics along 
the left side of the window that allow you specify how the SEG-Y file is read and how the bitmap 
is displayed.  These topics are described in detail below.  Once you have configured SEG-Y 
Reader to process your file correctly, you may store the configuration details (Configure menu | 
Save Configuration) to more quickly process similarly formatted files. 
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File type 

2D SEG-Y files may be exported to a Windows BMP file, a Geosoft grid (.GRD), and/or a Geosoft 
database (GDB).  When you select the SEG-Y file to be processed, be sure to set the file type to 
“2D SEGY files”. 

3D SEG-Y files may be exported to a Geosoft voxel and/or a Geosoft database (GDB).  When 
you select the SEG-Y file to be processed, be sure to set the file type to “3D SEGY files”.  You 
may examine 3D SEG-Y files, but exporting to either Geosoft voxel or database requires an 
Oasis montaj license. 

SEG-Y format 

The initial topic displayed contains options for reading the basic SEG-Y format.  The text header 
may be encoded as either ASCII or EBCDIC (default).  Byte ordering may be either Big Endian 
(default) or Little Endian.  The trace data format may be one of:  IBM Float (4-byte), IEEE Float 
(4-byte), Fixed (4-byte), Fixed (2-byte), or Fixed (1-byte).  SEG-Y Reader attempts to determine 
the correct format for each part of the file by scanning the binary and trace headers when loading 
the file.  The View menu contains tools to examine each portion of the SEG-Y file in order to 
determine the proper format and header locations. 

View Text Header 

Using the encoding specified in the Header Encoding field, this dialog displays the contents of the 
Text Header.  Look here for notes about formatting, sampling, and processing.  If the contents 
appear to be “garbage”, close the dialog, change the Header Encoding, and View Text Header 
again.  The Text Header may be empty. 

View Binary Header 

The Binary Header specifies the formatting of the SEG-Y file and some of the processing 
parameters.  You may override the relevant settings in some of the later topics. 

TraceViewer 

The SEG-Y format specifies a byte-offset and data format for each trace header field (e.g. Group 
X-coordinate & Group Y-coordinate at byte-offsets 80 and 84, both 4-byte integers).  In practice, 
binary header values are often absent or wrong, and trace header fields are frequently empty, in 
a different location, and/or stored in a different format. 

The TraceViewer is a tool that allows you to view trace headers and traces to determine the 
correct location and format of trace header fields and the correct data format for traces.  The 
TraceViewer is a persistent (modeless) dialog, so you can keep the TraceViewer on-screen as 
you configure SEG-Y Reader to read and process your SEG-Y file. 

TraceViewer can display the trace headers using either Little Endian or Big Endian byte-order 
and view the header fields at each offset in 2-byte and 4-byte formats.  Scroll through the traces 
to determine the range of trace-header values, or move to a specific trace.  The TraceViewer also 
displays the current trace as a wiggle-trace at the bottom of the dialog.  Try different data formats 
to determine how the trace values are stored. 

The TraceViewer does not change the Byte Ordering or Trace Data Format used to process the 
SEG-Y file.  You must change the settings in the topics (e.g. SEG-Y Format | Options). 
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Trace Options 

Trace Order 

Specify the order in which the traces will be processed from the SEG-Y file.  

The first option is to load the traces sequentially, as they appear in the SEG-Y file.  To do so, 
select the Sequentially radio button.  This is the default option of the SEG-Y reader. 

The second option is by trace number.  You do this by selecting the By Field Value radio button, 
and then specifying the byte-offset and data format of the trace header field that contains the 
trace number information.  When you have selected the correct byte-offset and data format, push 
the [Apply] button to see the values found in the first trace. 

Navigation 

This topic allows you to specify the 
source of the traces‟ coordinates. 

None:  Use along-line position 
This option is used when the group 
coordinate location is unknown.  The file 
can‟t be projected onto a section, but 
will be shown with equally-spaced 
traces, one trace per pixel or grid cell. 

Coordinates in Trace-header fields The 
default utilizes coordinate data within 
the trace headers.  By default, byte-
offset 80 contains the X-coordinate and 
offset 84 contains the Y-coordinate, and 
the data type for the group coordinates 
is a four-byte integer.  However, some SEG-Y files may store the coordinates in other data 
formats and other locations.  You can override the default location – use the TraceViewer to 
examine the trace-headers and scroll through the traces to determine which headers change.  
When you have selected the correct byte-offset and data format, push the [Apply] button to see 
the values found in the first trace. 

The third option, External Navigation File, allows you to specify an external text file containing the 
navigation (or „NAV‟ file).  You must specify which columns in the NAV file represent the trace 
number, group x coordinate, and group y column.  The trace-number in the NAV file will be 
mapped to the Shot Point number in the trace headers.  By selecting the Interpolate Missing 
Trace Coords: checkbox, SEG-Y Reader will linearly interpolate the position of any traces not 
directly mapped. 

If the file contains navigation for multiple SEG-Y lines, specify the “Line” column in the file and 
select the appropriate line from the pull-down list. 

Decimate 

This topic allows you to specify whether or not to skip any traces while processing the SEG-Y file.  
Setting a non-zero value here causes the program to skip the designated number of traces. 

Trace Windowing 

This topic allows you to specify the range of traces that will be processed.  By default, all traces 
are used.  Select a range of traces if you wish to use only a subset of the file. 
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Shot Point 

This topic allows you to specify the byte-offset and data format of the trace header field that 
contains the shot point number.  The default location and format for the Shot Point is at offset 16, 
4-byte integer. 

The SEG-Y reader uses the shot point numbers as labels for the bottom axis ticks on the 
generated bitmap.  These values are also used to map traces to coordinates when importing 
navigation coordinates from an external file. 

Interpolation 

This topic specifies whether or not the SEG-Y sample values should be interpolated across the X 
(horizontal) direction. 

Since the SEG-Y reader projects traces of the SEG-Y file onto a two-dimensional plane, spaces 
(vertical columns of blank pixels or grid cells) can appear in your data (depending on the variance 
of the trace separation along the projected plane).  The „Linear‟ option (set by default) will perform 
linear interpolation to fill in the spaces in your data. 

Vertical Sampling 

Sample Specs 

This topic provides three functions; the first for windowing the range of samples read in for each 
trace, the second for setting the Sample Interval value, and third, specifying the units of the 
Sample Interval.  A fourth area shows the upper and lower limits, in Time or Depth, based on the 
values entered. 

By default, the All radio button is selected and all samples are included.  To limit the sample 
values used in each trace, select the From radio button, which causes the From and To text fields 
to become enabled.  Enter the From and To sample position values, which can range from 1 to 
the maximum number of sample values per trace. 

The Vertical sample interval is read from the SEG-Y file‟s binary header.  You may override it 
here.  This value, together with the windowed sample value range, is used to determine the scale 
of the left axis of the generated bitmap or grid, and the vertical dimensions of a voxel. 

The Vertical axis units option determines the label used on bitmaps, and the units of the vertical 
grid and voxel axes.  Both may be changed later from within Oasis montaj. 

Orientation 

There are two topics, Origin/Azimuth and 3D Survey Geometry in this section.  Origin/Azimuth 
settings are only pertinent to projecting 2D SEG-Y files onto oriented vertical planes.  3D Survey 
Geometry contains settings to determine the placement of traces into a 3D grid (voxel). 

Origin/Azimuth (2D SEG-Y) 

This topic allows you to specify the orientation of the vertical section upon which the SEG-Y data 
will be projected.   

Default: No external orientation information is available.  In this case, the values are calculated 
from the first and last traces in the SEG-Y file. Upon completion of processing the SEG-Y 
file, you can return to this topic to view the calculated values. 

No projection causes the file to be exported “as is”, with each trace equidistant from the last no 
projection.  This is useful if you have no orientation information at all, or if you want to 
export the SEG-Y to a database unprojected. 
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Manual will use the Origin/Azimuth information entered below in the dialog when processing the 
SEG-Y file. 

From GM-SYS model allows you to select an existing GM-SYS model to determine the profile 
direction and location.  The reader will project the data onto this profile.  If SEG-Y Reader 
was called from within GM-SYS, this option will be automatically selected and the 
appropriate orientation information filled in. 

3D Survey Geometry (3D SEG-Y to voxels) 

3D seismic surveys are collected and processed to a rectangular grid of traces.  The In-line and 
Cross-line coordinate of each trace determines the location of that trace in the grid.  However, the 
trace position information is not always stored in the trace headers. 

There are two options for specifying the location of each trace.  In each case, a simple product is 
used to determine whether the entered values match the volume.  If not, you will be warned, but 
allowed to proceed. 

None:  If the In-line and Cross-line coordinates are not available in the trace headers, you may 
specify the number of In-line and Cross-line elements in the SEG-Y volume, and allow them 
to be loaded sequentially into the 3D grid (missing traces will produce dummy traces at the 
“end” of the voxel), or 

Survey Information:  You may specify the In-line and Cross-line minimum values, the increment, 
and the number of elements.  Then specify the locations (byte-offset and data format) of the 
In-line and Cross-line coordinates in the trace headers (use the TraceViewer to examine the 
headers).  This will place each trace in the correct location within the volume.  Dummy traces 
will be included at each location in the volume that no traces are read with the correct In-line 
and Cross-line coordinates. 

When you attempt to save the 3D SEG-Y as a voxel, you will be asked to provide the voxel name, 
origin (minimum X- and Y-coordinates of the survey), the sample interval (in real distance 
units) along the In-line (X) and Cross-line (Y) axes, and the rotation of the survey relative to 
the X- and Y-axes (degrees clockwise from X).  The information in the Navigation topic is not 
used.   

Image Options 

Tick Marks 

This topic allows you to set the number of ticks along the axes of the generated bitmap.  Specify 
the number of tick marks for each axis and the axis will be divided linearly. 

Setting a tick value to 0 will turn off ticks for that axis.  

This topic has no effect on grid, database, or voxel output.   

Grid Lines 

This topic allows you to control the visibility of the grid lines on the generated bitmap.  By default, 
both the horizontal and vertical gridlines are turned on. 

Setting the gridline visibility does not affect tick visibility; see the „Ticks‟ topic for setting the 
number of ticks along an axis.  

This topic has no effect on grid, database, or voxel output.   
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Color Table 

This topic allows you to set which color table will be used to represent the trace sample values on 
the generated bitmap.  An equal area algorithm is used to map colors to trace values.  Default 
uses an internal red-white-blue (high-zero-low) color table, also included separately as 
“rwb17.tbl”.  Black and White uses an internal black-gray-white gray-scale color table.  From File 
allows you to select any Geosoft-compatible RGB color table to use (e.g. “rwb17.tbl” or orange-
white-black “beaver.tbl” are included with the software). 

This topic has no effect on grid, database, or voxel output.   

Size Constraints 

This topic allows you to set the maximum file size of the generated bitmap.  By default, the 
SEG-Y reader attempts to represent every trace on the projected vertical plane of the generated 
bitmap or grid. This can result in a large bitmap or grid size, particularly when traces are close 
together after being projected onto the two-dimensional plane. 

To prevent extremely large bitmap sizes, set this topic‟s value (in kilobytes). 

This topic has no effect on grid, database, or voxel output.   

Output 

When you have configured the SEG-Y Reader to correctly process your file, you may save it to 
the desired format. 

2D Images (BMP or GRD) 
(2D SEG-Y only) 

To generate an image for viewing, select the Image tab, click Apply in the lower-right corner, or 
select Configure menu | Apply configuration and generate image.  The file will be processed and 
the image displayed.  Note that the projected coordinates of the upper-left and lower-right corners 
of the image are annotated on the image.  Unselect the Fit to Image checkbox in the upper right 
corner to see the image at full-size.  Scroll around the image to view axis labels, titles, and other 
annotations to the image. 

You may select the Configure tab at any time to change the configuration, then regenerate the 
image. 

If you are satisfied with the image, you may save the image (File menu | Save Image as).  Select 
the file type, Bitmap files (*.bmp) or Geosoft Grid files (*.grd), and specify the location and file 
name to write. 

You may save the same image as both Bitmap files (*.bmp) and Geosoft Grid files (*.grd). 

Geosoft Database (GDB) 
(2D- and 3D SEG-Y) 

You do not need to generate an image for viewing in order to export to a Geosoft database, but it 
can be useful for verifying configuration.  Navigation coordinates used (either specified in the 
trace headers or added via an external NAV file) will be incorporated as channels in the output 
database. 

Select File menu | Export as Geosoft Database and specify the location and file name to write. 
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Geosoft Voxel (geosoft_voxel) 
(3D SEG-Y only) 

Select File menu | Export as Geosoft Voxel and specify the location and file name to write.  You 
will be presented with a dialog to specify the location and file name to write, the voxel origin and 
sample interval (minimum X- and Y-coordinates and In-line (X) and Cross-line (Y) sample 
intervals (in real distances)), and the horizontal rotation of the voxel around the voxel origin, in 
degrees clockwise from the X-axis. 

Calling SEG-Y Reader from GM-SYS 

When loading a bitmap in GM-SYS, you will have the option of loading SEG-Y files directly.  This 
will call SEG-Y Reader from within GM-SYS, passing the model information to SEG-Y Reader 
and loading the selected SEG-Y file.  If the SEG-Y file and GM-SYS ECS coordinates utilize the 
same coordinate system and projection, the SEG-Y file will be projected into the correct location 
on the model cross section.  After you save the BMP image, close SEG-Y Reader and the image 
will be loaded into GM-SYS. 
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